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"Introduction”

Thank you very much for purchasing the "Fi" system ECU (Electronic Control Unit)

"FI" is a fuel injection system for small displacement motorcycle, and this system is not a
simplified but a full functional system, as well as it of large displacement Motorcycle. ECU can
detect various states of engine by various sensors and control the optimal volume of fuel.
Furthermore, if you use this system, it is possible to set up almost all the parameters about
Injection with the personal computer linked to ECU. Almost all parameters can be set up by the full
range. Of course, you can use a setup which FC design prepares and can also do a setup from
zero.

Please read notes of the following page before beginning to use this
system.

If you have any questions about this system or instruction manual, please contuct us.

FC Design

2-1-48-101, Honmachi, Fuchucho, Akigun,
Hiroshima, Japan postcode 735-0006
Tel +81-82-287-0211

Fax +81-82-287-0212
http:/lwww.fc-design.com

E-mail:info@ fc-design.com
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"Attention"

(1)  This product is only for racing use. Therefore, we recommend strongly that you use this
system in safe places which can respond to the emergency engine stole by the mistaken
arrangement etc., such as a circuit.

(2) Please install controller in the place which avoided raindrops, splash, etc.

(3) Do not install a controller in places which become high temperature extremely, such as
near an exhaust pipe.

(4)  When you arrange setting or check this system with engine started, we recommend you to
go in a well ventilated place,strongly.

(5) Since high pressure has started the fuel line, please check pipe and hose to keep a
performance and safety. Moreover, please be sure to check before a running.

(6) In order to avoid the accident, please decompress the pressure in fuel line before
decompose a fuel pipe system.

(7) Do not use this product other than the original purpose.

(8) You shall not about this system(Hardwear,Softwear,Documents,etc.):
(a)Copy, in whole or in part.
(b)Modify
(c)Reverse engineering of the composition parts of this product containing software.
(Reverse compile or reverse assemble the PC softwear and ECU firmwear)
(d) Transfer software, a document, and CD-ROM independently.

(9) When you use this system combining the products of the other company ,we do not take
responsibility for other company's products .

(10) Ifyou have troubles and accidents by using this product without observing notes above,we
will not take no compensation and responsibility.

A Caution

fuel Fire strict avoid avoid

pressure prohibition exposure static
over in to water electricity

4kgflcm? disassembly and
electric

shock
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"When you connect ECU to the system harness..."

(1) After removing terminal of vehicle wiring which are connected to the battery, connect
system harness to wiring of vehicles, attach or remove ECU to system harness.

(2) When ECU is connected for the first time, please look at the lamp display of ECU well.
Please turn off a switch promptly, and check the polarity of a power supply, and
connection, when a power supply lamp does not light up.

(3) When you disconnect a coupler from system harness, be careful not to cut the wire of it.
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The chapters shown in a red character are going to translate into English now.




(3) configure and sensor ajustment
(a) Setting of close values and
full open value of throttle sensor
(b) Threshold of Idle Throttle .
(c) Adjust "Map" to

"Injector Capacity” & "Engine Displacemant.

(4) To start "Map Setting" -- Hint of work
(a) "constant" load(throttle) setting.
(b) "(rapid)Change Thrpttle" setting.
< Asynchronous Injection>
(5) Appendix.
(a) spec.

FCdesign

p3-1
p3-3

p3-4

p4-1
p4-3

p5-2

* Microsoft and Windows are registered trademarks in the United States

and other countries of Microsoft Corporation(USA).

The chapters shown in a red character are going to translate into English now.
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(1) " Product Outline"

(a) ECU exterior

Photo. " Fi" system ECU (Elrctronic Control Unit)

Coupler
:ECU10P
:10pins

Connector for
Coupler communication

:ECUBP : g cable
:8pins __ S A

/

ECUBP,ECU10P : In case a coupler is connected, a main part is pushed in by hand until sound
"Click". When disconnecting , couplers are pulled, after pushing in the button of the coupler upper
part.

Be careful notto cut the wire of it.

A communication cable connects only the cases at the time of an setting arrangement etc. with
PC serial port by the cable contained in this products.
In addition, it can attach also in the state of power supply ON, or can remove.
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Photo : ECU has two display lamps.

Red : Information Indicator
Lamp ( Same Function as
Dial Controller Lamp)

Green : Power Supply Indicator
Lamp

The lamp on the right-hand side of a photograph is a lamp of the red which performs a system
information display. It is the display of an injection timing signal input, a system error, etc.
Display function is almost same as dial controller lamp. (except a shift-up indicator function)

*Please read Chapter (f)"Lamp Display Function " for details..

The lamp on the left-hand side of a photograph is red lamp ,ECU power supply indicator, when
the power supply is on.

When IG key-off, ECU power OFF is postponed only for between the change check of
arrangement data. In this period an ECU power are supplied from "Backup" wire of system
harness which is connected to battery plus terminal. After that, ECU is turned off and holding data
does not need power supply.
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(b) Fuel Injection Control

The volume of fuel is controlled in time of ON period of injector.

Volume(cc) = Injector flow rate(cc/min) / 60 (sec) x Injector ON period (sec)

By the text after this, time of ON period of injector is called injection time.
You can setinjection time to 32msec at the maximum in each cycle. Injection time is calculated as
follows.

Injection time (Ti)
= Basic Time(Td) x Startup Compensation x Warm-up Compensation x * Acceleration Compensation
+Injector Dead time

* Speed-Density System Only (* D-Jetronic version)

You can setthese compensation values to "1.0" quickly with each enable/disable property on
software.The lower figure expresses control of injection.

Startup Warm- *Accel.
Comp. up Comp. *Speed-Density System Only (*D-
(Ks) C(OKT\,‘))' (Kd) Jetronic version)

Basic Td’é ’é l Ti .
; TilTs
Time X X @ > Change

(Map)

Control
Ts b
Startup |———P» y
Injection R.P.M.
Time l
Please Read Chapter(e) c Dtialll
about " Dial Controller." ontoller

Fuel

i
®

R.P.M. > Injector
> cut Bg Limitter Drive
Control
Asynchronous
Injection
control

The outline of each control is explained in the following page.

*"D-Jetronic" is the registered trademark of Bosh AG
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" Basic Injection Time "

Throttle - Speed Control Version (Alpha-N)

There is a map of injection time to the volume of intake air determined with two parameters, the
open angle of throttle and engine speed, in ECU, and the "basic injection time" is determined with
reference to the map. Even when the open angle of throttle and engine rotation speed take the
value between axes, the injection time is computed by complement calculation.

An injection map can be edited from PC.
The axis of a map can be setup to 31 at the

. Injection Time (msec) -|
maximum to each of the open angleof throttle, 1mesc fscale /////
nd engine rotation i ibl ey
a de.g e rotation speed t.spossbet.oset /?;;6//// /]
up arbitrary number of the axis to the arbitrary ; /fz,ff’/f//{/ 7 /|
axis value in this range. A /7 /]
/“//‘,////// L /
ffff;/ r/ A // /s /
S - 100
I” f A
=, A~
/ .
A e L Tt e oo
— i
1] 46000

Fevaolution Speed (RFM)
J1000rpm f scale

Speed - Density Control Version (*D-Jetronic)

There is a map of injection time to the volume of intake air determined with two parameters, intake
manifold pressure and engine speed, in ECU, and the "basic injection time" is determined with
reference to the map. Other control function is same as "Throttle-Speed Control".

This Control Method is best for super charged engine(turbo,etc.). In a super charged engine
version, intake manifold pressure is detected to about 2 kg/cm2(1600mmHg).
(Normal version sensor is up to 800mmHg.)

Injection Time (msec)
imsec ! scale

* Accelerate Compensation is only for
"*D-Jetronic". 14 [ /
See Detai (Section) /

//' /

i //
T i
/x/ 7 - /’X /}{ 7
7 rars i x")
L j,/ L //",/ / " Wanifold Pressure
=5 e f;”. "J, " // (mmHg)
o 140mmHgfscale

1] 0 16000

Fevalution Speed (RPR)
JS1000rpm ¥ =cale

*"D-Jetronic" is the registered trademark of Bosh AG
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"Compensation”

Please read Chapter 2 for details.

Warm-up Compensation
(Engine Temperature Compensation)

This is compensating the lack of fuel evaporation and increase in volume of air filled in engine
when engine has got cold.

Start up compensation

This is compensation which increases fuel after starting of engine until it carries out stable
rotation.

Start up injection time

This is not a compensation value. It is injection time which will be injected in a period until it
becomes a rotation speed stable.

Asynchronous injection time

Asynchronous injection is the function to perform compensation injection, when change of the
intake air volume rapidly between the timings of synchronous injection.

Fuel Cut Control

In engine rotation speed over idol speed, fuel injection is stopped at idle throttle position. This
functions also as an idol R.P.M. limiter.

Accelerate Compensation (for *D-Jetronic only )

This function correct a gap of the air / fuel ratio resulting from change of the intake pressure by
acceleration or slowdown. It differs from the asynchronous injection which performs compensation
injection temporarily that the volume of synchronous injection is increased or decreased between a
certain set-up cycles.

*"D-Jetronic" is the registered trademark of Bosh AG
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(c) Other Controls

"Pump Control"

The pressure of fuel is required for fuel injection. The in-line pump is controlled from ECU. In
order to suppress useless consumption of a battery, intermittence according to required quantity is
driven in the low rotation speed domain. The PWM drive is performed in the high rotation speed
domain. It is possible to perform a setup of a drive from PC connected with ECU.

*ECU is not measuring the pressure of fuel. Please set up the parameter of ECU, looking at the
pressure gauge attached to this products("Fi System set") so that required pressure may be
obtained.

"Revolution Speed Limitter"

Fuel injection will be stopped if it becomes more than the set-up rotation speed. You can set it as
arbitrary values from PC.

"Shift-Up Indicator”

The lamp with which the dial controller is equipped is turned on when it becomes more than
arbitrary rotation speed. You can use it as a shift-up indicator.

*Option "Extended Injector control”

ECU also Contorols Extend Injector for Oxygen injection system(Option).
Please read the description of an oxygen injection system for details.

Please read Chapter 2 for details.
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(d) Other Parts of System

" Throttle body "

It is the throttle of a rotary valve. Injector, the
throttle sensor, and the extraction mouth of intake
pressure are attached to this.

" Signal interface unit"

This is the unit which makes the signal for injection
from an ignition signal. This makes 1 time of a
signal to two rotations of a crank.

" Temperature sensor "

The element for temperature detection is enclosed.
It attaches in the cylinder side and the temperature
of engine is detected.

" Dial Controller "

There are a dial which changes fuel injection time by
one point temporarily, and a lamp which displays
information in this. The chapter(e) explains for
details.

"Fuel pump "

Itis the in line pump for fuel driven on the voltage of
12V. The maximum output pressure is about 4
kgflcm2. The rated pressure of a system is 2.5
kgflcm2.

1-7



" Fuel pressure regulator”

It attaches in the fuel piping. This keeps the
pressure of fuel constant.

" Accumulator”

This suppresses change of the output pressure of a
pump by which an intermittent drive is carried out.

" Pressure sensor "

This detects the pressure of intake manifold.
This sensor is only for "D-Jetronic system”

Sensor of version for supercharged engine
maximum : 1600mmHg( about 2kg/cm2 )

Sensor of version for normal engine
maximum : 800mmHg ( about 1kg/cm2 )

FCdesign
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(e) Dial Controller

Photo : Dial Controller

Information
Fuel C | Indicator
l_Je ontor Lamp
Dial
" Function "

The "Dial Controller" is equipped with the dial which can increase or decrease injection time
(whole map) temporarily, and the lamp which displays the information on ECU.

Itis possible to change injection time in the quite big range from 0.1 times to 1.9 times by the dial.
A left rotation side is the direction of "rich" (upper scale 1-1.9 time), and a right rotation side is the
direction of "lean" (lower scale 0.1-1 time). The minimum scale is 0.1.

In addition, since a setup of the range corresponding to a dial can be changed into arbitrary values

from PC, adjustment width can be made large (for example, 0.05 time -4 time etc.), or it can be
narrowed (for example, 0.5 times to 1.5 times etc.).

Please read Chapter (f) for " Lamp Display Function" details.
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The example of use of a"Dial Controller”

Although, as for a dial controller, only a primitive setup of changing the whole can be performed,
according to a way, it can use for the arrangement of a map quite conveniently. The following is
an example of use of a dial.

(1) After attachment "Fi", when starting the engine for the first time, the engine can be
started correcting a gap of the injection time of the original map with a dial.
You put engine into operation, turning a dial and changing various injection time first.
You look for a dial position so that engine may carry out stable rotation. After engine
starts, you look for the position which engine strats misfire by turning a dial. Thereby,
you can know the "Rich" side limit of the injection time, and the limit by the side of
"Lean”. You read the scale of a position which turned to the "Rich" side a little from the
middle of those dial positions.You can know that that is the best injection time near an
idol. It is good for you to adjust the injection time of the idol area of a map with this
value of a dial.

(2) It may be good to apply the multiple value which corrected an idol's injection time also
to the whole map.

(3) It is very difficult to touch a dial during a runnig, so you turn a dial before running and
you run at a certain degree of throttle. You run in the some dial position and read the
dial position which becomes the largest power. And you correct the injection time of
domain, which you check on the map.

(4) When decomposing a fuel piping system, it enables you to lower fuel pressure simply
by continuing operating engine, with a pump suspended. At this time, it can lower to
remarkable low pressure by consumption of fuel pressure with engine by turning a dial
to a rich side with descent of fuel pressure.

1-10
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(f) Lamp Display Function

The red display lamp of an ECU and the display lamp on "Dial Controller" display the following
information.

(1)

The display of an injection signal input

An injection pulse will be inputted into ECU if engine is rotated using a kick pedal or a
cell motor. When not engine starting, ECU performs "ON" and "Off" an information
lamp at every input of a signal. If engine starts, this display function will be ended. You
can know whether the function of a signal unit is normal by this display.

Shift-Up Indicator
( *Dial Controller lamp only)

The light is switched on when it becomes more than the engine rotation speed set up
by control software (SWB).

Injector wiring disconnection warning

The light is switched on when wiring to injector is disconnected. A lighting pattern is
as follows.

< = )\

C— OFF

1.2sec
Pump wiring disconnection warning

The light is switched on when wiring to a pump is disconnected. A lighting pattern is
as follows.( *Notel )

< m O\

C—3 OFF

Battery voltage warning

The light is switched on when the voltage of a battery becomes low too much. (* Note
1and 2) A lighting pattern is as follows.

0.2sec
< N o\
[ | || I I ]
L—1 OFF
1.2sec
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(6) Warning at 100% duty cycle

The light is switched on when the injection time exceeds time while a crank rotates
two times. That is, it means that only injection time as set up cannot be injected.
Usually, although it is thought that such a thing does not happen, when this display
comes out and engine is turning at " Lean", it means that the injection capacity of
injector is insufficient. A lighting pattern is as follows.

< m )\
— oFF

(7) Setting map reading error warning

ECU reads the map for control from a memory, when starting. This warning display is
turned on when a map has an error. When this display comes out, a controller stops all
control. When a warning display does not disappear even if it reboots ECU after
transmitting the map saved at PC again, please contact us. A lighting pattern is as

follows.
0.2sec
<>
B T T e | s 2B O\
C— oFF
1.2sec

1.2sec

*Notel Warning - Voltage & Pump

Pump wiring disconnection warning and Battery voltage warning are detected only
when the drive mode of a pump is "Pulse Drive". They are not detected when the drive
mode of a pump is a PWM drive. (However, they are detected at the time of starting of
ECU.)

*Note2 Battery Voltage Warning

Battery voltage warning is turned on when it's voltage becomes less than 12volts. Usually,
since it is normal that the battery is maintaining more than 12volts, when such a display
comes out, please charge the battery promptly. Since it is thought that the pump drive cycle
is too short (too much driven)when this display comes out frequently, |1 ask you to improve a
pump drive setup. In addition, even when this display comes out, injection control does not
stop. When it should become low voltage during a run, the fuel volume of injection
decreases by the fall of the pump pressure. In this case, it is possible to run by turning a dial
controller to a rich side and compensating the insufficiency of the fuel volume of injection.

FCdesign
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(2) " Tutorial of PC software [ SWB ]"

The setting value of ECUs, such as basic injection time and a compensation value, is set up by
the control software "Setting Workbench For Windows" (the text after this describes "SWB")
which operate with the personal computer (*Notel) of Windows (*Note2). Next, the outline of how to
use this control software is explained.

*Notel ) A serial portis required for the personal computer which uses SWB. When there is no
serial port, we recommend you use of a USB serial conversion adapter.

*Note2 ) Windows98 Second Edition, Windows Me, Windows2000, Windows XP

(a) How to Install

Please double-click Setup.exe in the folder corresponding to each version of Windows. In
Windows2000 and WindowsXP, please double-click Setting Workbench.msi. Please complete
installation with reference to the message displayed on a screen.

The newest information about the combination of corresponding OS and setup file, and installation
method are indicated on the label of a CD-ROM case. Please perform after a check.

*When you install, please be sure to end other applications.

Icon of "SWB"
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(b) Outline of "SWB"

"SWB" mainly has the following functions.

(1)

Edit "Basic Injection Time" Settings p2-11
A setup of "basic injection time" is possible. It is possible to set the rotation speed axis
and *throttle angle axis of the point which sets up "basic injection time", as arbitrary
values. It is possible to multiply the whole setting map or arbitrary domains by a
constant value.
*In D-Jetronic, throttle angle axis changes intake pressure axis.
Edit"Compensation Table" Settings p2-22
The table of the following compensation coefficients can be edited.

Warm-up Compensation

Start up compensation

Accelerate Compensation ( for *D-Jetronic only )

Change Enable/Disable of Each Compensation p2-18

You can set these compensation values to "1.0" quickly with each enable/disable
property.

Edit " Start-up Injection Time" Setting p2-24

Setting of this function is also edited in the same window as edit of a compensation
table.

Edit "Asynchronous Injection Time" Setting p2-24

Setting of this function is also edited in the same window as edit of a compensation
table. You can stop "Asynchronous Injecton” quickly with enable/disable property.

Edit "Fuel Cut Control" Setting p2-24

Setting of this function is also edited in the same window as edit of a compensation
table.

Edit "Revolution Speed Limitter " Setting p2-21
You can change R.P.M. value of revolution speed limitter.
Edit "Shift-Up Indicator (Information Lamp of Revolution Speed ) p2-21

You can set the rotation speed which an indicator lamp turns on as arbitrary values.
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Edit"Pump Control" Setting p2-19
You can set up the pump control settings in "Pump Setting" window.
Change Enable / Disable of Dial Compensation of "Dial Controller" p2-18

You can disable the fuel injection time compensation dial of a dial controller. When you
use this product without connecting a "Dial Controller", please set up "disable".

Edit "Hardwear Configuration"

The following setup can be changed in this window.
Throttle bore and trottle sensor range.
Injector flow rate (feed rate, cc/min).
Idle Throttle position(%).
Injector reaction period(injector dead time,msec).
Dial Controller range.
Intake pressure sensor (boost sensor) range.

*Since the item set up on this window is adjusted to the composition parts of this
products[set], before shipping, you do not need to change those settings.

ECU Data Monitor p2-27

You can see the information in ECU using a "data monitor" function. An updating cycle is
about 1 time in 1 second.

Read settings form ECU and save to the file p2-7,p2-9,p2-10, p2-26

A setup read from ECU can be saved at a file. Moreover, a setup saved at the file can
also be sentto ECU.

2-3
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(c) Start and Exit

Start "SWB"

Please click [Start] > [program] > [Setting Workbench] ,It will start

ek | &

By Windows Update

ITISLE

BRIIADE@ Y ThE

O BE{ESE IR P b v
B EHFEE) PR Ms-DOS FOLTE

3 wEE g

B ALIH
T Ip{lphtsE L TEIT .

Windows (ES T (L.

The 2nd "SWB" can be started when one "SWB" has started. For example, it is possible to edit a
map etc., comparing the screen of two "SWB". However, since "SWB" does not take out
warning to saving to the same file in this case, be careful of management of a file.

Exit"SWB"

SWB will be ended when "end" button in the window upper partis clicked, or X buttons at the right
end of an upper end are clicked, or "Exit" of a "File" menu is clicked. At this time,since the

message which checks saving to the file is displayed when the read data has change, please click
"save" or "cancel".
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(d) How to Set-up the Settings -- "Map"

The flow of the work in the case of changing a setup is explained.

After starting, setting data is empty in SWB.
First, you need to read data from ECU or a file. Read from ECU Read from file
In this time, you cannot choose any items other
than "Open file" and "ECU >> SWB"

2-7 2-9

*(A) We recommend you to save the data read
from ECU bfore editing as much as possible.

Next, you change the item of the purposes,
such as basic injection time ,compensation,

pump setup,etc. *

Then, you save data or transmit data to ECU. 511
Keep in mind that change is not reflected in a Cahnge -~
setup in ECU until it "transmits." Settings 2-23

*(B) We recommend you to save data before
transmission at a file.

Since ECU reflects change in control
immediately after transmission, there is

especially no necessity of restart engine.

Save to Send
A changed setup is saved at ECU, when IG the file to ECU

switch is cut (when ECU is turned off).
2-10 2-24

If the present setup is previously read from ECU before reading a setup from a file when
changing a setup read from the file and sending to ECU, only a part with change will be
transmitted. The function to transmit only a change part is convenient, when changing a
setup and arranging it one after another.
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(e) Read Settings from ECU

You connect a personal computer with ECU by the
attached communication cable first. Since the window
of "COM PORT" opens when a "receiving” button is
pushed, please set up a port number and click the
"0.K." button.

A mouse icon becomes a sandglass display during
reception, and SWB cannot be operated in the
meantime. Reception takes about about 10 seconds.
When the message of the completion is displayed
after reception is completed, please click the "O.K."
button.

The port number of a serial port can be checked with
" system property"window of a personal computer.

\ .
E‘r‘j!-.

Since SWB displays an error message when the o
play g Connect "Communication Cable"

wrong port number is set up, please click a
[ECU>>SWB] button again after clicking [Tool] >
[Option] of a menu bar and clicking the right number
of the "COM PORT" and the "O.K." button.

Help

ECL >> SWE

Gontrolz  Bagic Map |Oom&

Recieve from ECU button

Wiew  Tool

COM PORT
& GObig
" COME
& COME
2271 21x|
S FIA TR T | ekorr F07 | KorA "COM PORT" Window
& HEERIHRTD  EERIETO
- =
E B B )
Sﬁ UK £, BAUF- L0200 File Edit View | Tool Help
[:I-E'l FAAD BT E i E Hardwear Gonfiguration
= @ F 2T PHIR :
w0 B b~ PHIA - IR B
B2 Y-k TAAL Jub0-3 Gontrols  Basic b Data Manitor
5 e T 10 — E—
S 5 #—F COM £ LPT)
- o DU = LPTT
1 iBER—} COMD) L .
i‘i B(EA 1 COM2) Correction of
[ SIA -
2 = a"COM PORT" number
JuAFR | EHHE [EIo| Enml. |
el

System Property Window
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If reception of a setup is completed, it will become a Date of Last Update
screen display as shown in the following figure. ¢ P ID of ECU

Y

|LAST: 2001/07/1313:41:18 | EDIT: ECL | ID: FIPLOOMS 01011034

ID of ECU and date of last update are displayed on a
status bar.

Status bar

b R Rr s WP

(ol x|
B =: | #s | wT
UEALE RS RIRE |(¥§EQE 1
o njection Time : 1 mseciscale
T 7/ !
[
Throttle Angle (%
/// Tzt
o 0 g
o 18000 @ @
Revalution Speed (RPM)
£1000rpm [ scale Throttle Angle : 10 Percent/scale
RERE
EHzEEEmER L4 AnhIFAEEER L8
[z EE - + |-
Bl it ] [+] 15000 [ ey =
EinEE A 14000
S 5oz [ | 715 |[E8] s=
i w  rpn ewa|| | 1ss % »s =
2 e R 5] e
|ST.DIS [PORT: 1| LAST: 2001/06/01 11:21:43 | EDIT: fle ID: FIPLOOMS010011020001 | INJ: 7cc | DIA: 16rmm o

*Transmission and reception of data with ECU are possible only at SWB corresponding to the

version of each ECU. Be sure to use SWB set up from CD-ROM appended to the product, or
SWB upgraded to the correspondence version.
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(f) Read Settings from the File

If the "Open" button in the window upper part is s Setting Workbench ver1.11.00 Ty
clicked, the dialog of "Open File" will apear. Please Ao Bt Miow Tosl el
select a setting file to open and click the button Open. | EGU>> 5WB | ©
"Open." The extension of a setting file is .swp. When
reading is completed and the message of "reading

Compenzat

completed” will be displayed, please click [0.K.] "Open" Button

button.
3 2%
FrA MOBAD [ Meap =l @ =
] teimp i,
Fr N Jtemp.swp [ |
7 LDIEERD:  [Fi Setting file towp) R ) y

Z|

"Open File" Dialog

Information

"Reading Completed"

*A setup of hardware is saved at the setting file. The data received and saved from ECU with
different ID cannot be transmitted.
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(g) Save Settings to the File

If a setup read from the file is changed or data is
received, you can save those data at a file. ECU ID
and last update of readed setteing are displayed on a
status bar.

A comment can be added to the file to save. For
example, engine specifications, such as displacement
volume, a setting place, the feature of a setup, etc.
can be written in freely. When you click "File" > "Save
As" from a menu bar,SWB displays the dialog box of
a comment input.

(if you will carry out overwrite, please click "File" >
"Save" of a menu bar.)

When this dialog box is displayed and it is going to
save a setup read from the file, the comment in the
file saved at origin is displayed on the window. In the
case of the data read from ECU, it is displayed as "No
Comment." Input a comment here freely and click the
"0.K." button. Please click "O.K." to save with the
comment currently displayed. Please click "Cancel"
button, when a comment is unnecessary. In this case,
a comment is saved with "No Comment."

If "O.K." or "cancellation" button is clicked in
comment dialog box, the dialog box of "Save file" will
be displayed. Please save file in arbitrary file names
and folders.

Date of Last Update '

¢ N

|LAST: 2001/07/1313:41:18 | EDIT: ECL | ID: FIPLOOMS 01011034

Status bar

ting Warkbench Yer111.00 Type

File Edit ‘“iew Tool Help

Open Settine Fils WE | SW
Save

mpenzatiol

Setting Export
Setting Import

Download From ECU
Upload To ECU

| Exit..l: // p

ZATEMUTIRE 2l

5 ol dlEE

RETHEME: [

temp.swp
4 3
7 LB I RS I

7 LDAEAAM:  [Fi Setting file tzwp)

- FiAa)
o _setn |

Save As ...
[Fia Comnant x|
Tpd commants for sevine Fike.
me CORmEREs . CarcelMD comHeE
Feil

[I0T033 Trpe TB 12ex Superharesd|

Comment dialog box

You can check comment of current setting at "file comment" in the "Data Property "window,

displayed on clicks "edit" > "property" of a menu bar.
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(h) Edit "Basic Injection Time" Settings

* |n the case of the D-Jetronic version, please read " the throttle angle" as "intake pressure."

How to change a setup of basic injection time is fizclian Time (msec) =
explained in this chapter.
Basic injection time can be changed by the following 5

ar

two methods.

100

(A) The method of changing a value for every
point set up by the engine rotation speed axis and

Throttle Angle (%
1D%iscﬁ\eg ®3

throttle angle axis. " s

every point set up by the engine
(B) The method of multiplying "Gain" to every rotation speed axis and throttle
domain of throttle angle. angle axis.

Open. | ECU> sWB | w8 K

(A)"Changing avalue for every point"

sontrols  Basic Map |Oompensation I

If the tab of "Bsic Map" is clicked, the screen of basic Inction Time (msec)
o . . . . Amzec f scale
injection time will open.You can change a value in the

form of the window lower part. _ o
the tab of "Bsic Map"

When you click _« I » ]button of "Edit RPM Axis"

" . o . . Edit RP.M Axis Mum Edit Pressure Axis Num
and "Edit Throttle Axis ", the point of which you can R AN e
edit "injection time" moves. Please move a point to P e e
whitch you want to set up. The current point is shown e = o -
by blue circle. [ om0 e« [ 20
If >button is clicked, a point will jump to an axis of %8 T 0 45% e
end.

Moreover, when you delete the axis which became "Edit RPM Axis" and "Edit Throttle Axis "
unnecessary or you newly increase an axis between
axes, please click [#[=]button of each axis window. IS SR
The position of an axis can be adjusted with slider.
[ U [+
You can input a value directly to | 6914 | A |
, and click "O.K." button. In this case, you need to
input a value between neighboring axes. o
1] 100
Injection time settings of points in a plane at the 2D Display (points in a plane at the
selected R.P.M. axis are displayed on right side selected R.P.M. axis )

graph window.It will be good to set up referring to left
side 3D display and right side 2D display.

Thjection Time{mszech

You can change injection time with the slider 2] Z0000 o
Kl o [*] , can also put a direct value into 11000

sec
box | g1 ®# | and push "O.K." button on =

“Injection Time" window.

E| 00.000

"Injection Time" window.
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When the point of graph has exceeded the maximum
of a vertical axis in the result of editing injection time,
please click "View" > "Standard View" of a menu bar.
The maximum value of a veratical axis will be
adjusted automatically. Moreover, if "View" > "Zoom
In" of a menu bar is clicked, graph will be displayed
zooming in low rotation speed and low throttle angle.
This is convenient when changing an idol domain.

(B) Multiplying "Gain" to every domain

When you click the "Set by Gain" button of the "Input
Method" window, the window that has many sliders
£l 0 B foradjustment displays. Please
adjust a window position so that a map display is in
sight, as shown in the right figure.

(B-1) How to use multiplier ,"Gain"

The slider 1« 0 ™ ina"whole Map Gain"
window is used when multiply a value to the injection
time of all points.

In the "Gain of Throttle Range" window, the values in
the right side of "throttle %" are the throttle angle of
the degree domain boundary, and the values under
sliders 1w I are multiplier to the points in
their domain.

The injection time of the points in a domain between
the both boundarys are multiplied by the values which
are calcurated by values of both boundary using
linear Interpolation.

A map shape changes with this adjustments on the
graphs in main window. This change will be decided if
"0.K." button is clicked.

Please click a "Cancel" button to cancel added
change. It returns to the settings before a window is
displayed.

When which button is clicked, a window is closed,
and a bordering setting value etc. returns to a default.
The "Gain" calculates based upon an injection setup
before a window display as 1.0.

FCdesign

3 Setting Workbench Ver111.00 Type T8 [&¥Lavier
File  Edit | View Tool Help
Opet.. Zoom In ol
Change RPM Axis Max.
Controls Standard Wiew
Gitapt Golor [ S—
Mection &t Key Assign »

- o el ]
"Set by Gain" Window
[ e A
Input Method
Yhale Map Gain i
Set By Time
Walue 1 =
4
Set |
i Gain | -
1000

AT AAnT

“Input Method"

Gain of Throttle Ranee
T(,grottle 0- &1 100 400 650 1000

Cancel

- - - - -

&+ Gain

" Ranee

"Gain of Throttle Range" window
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"Compensation”

Warm-up Compensation
(Engine Temperature Compensation)

This compensation is compensating the lack of fuel
evaporation and increase in volume of air filled in
engine when engine has got cold.

You can set the value to each temperature points up
to 3.5. Usually, 1.0 or more values are set to the
temperature of 70 to 80 degrees C or less.

Start up compensation

This is compensation which increases fuel after
starting of engine until it carries out stable rotation. At
the time of engine starting, a setting value is
determined from the table of this compensation setup
based on engine temperature. After starting reduces
a compensation value at a fixed rate. Compensation
is completed when a value is setto 1.0. You can set
the value to each temperature points up to 3.5.

Reduction value of compensation is setin the lower
side of compensation window.

FCdesign

Compensgation Yalue (1717 0.5/scale
35

T

-50 1] 170
Engine Tempersture(degC) | 20 degClzcale

Compensgation Yalue (1717 0.5/scale

]
I

-50 0 170
Engine TemperstureldegC) @ 20 degCizcale

— time to recovery

Time : Slseciscale
172

—_temperature at —
=40
deg’

— reduction value —

1]
Rewaldtion Speed (FRPh) : 1000F Phiiscale

oo -]
=

16000

There is swicth in right side of window. =1 When you click an upper switch, a reduction value
increases. Thereby, the time to the completion of compensation becomes short. Conversely, if a
lower switch is clicked, the time to a compensation end will become long. Graph expresses the

compensation end time in display temperature and R.P.M.
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Start up injection time

This is not a compensation value. It is injection time
which will be injected in a period until it becomes a
rotation speed stable. It is not based on the angle of
throttle, and rotation speed, but fixed injection time is
set up for every point of each temperature. Since
evaporation of fuel runs short when engine
temperature is low, injection time is increased.

Asynchronous injection time

Asynchronous injection is the function to perform
compensation injection, when change of the intake air
volume rapidly between the timings of synchronous
injection. Asynchronous injection time is set up to the
point of the amount of open angle change of throttle .

Fuel Cut Control

In engine rotation speed over idol speed, fuel
injection is stopped at idle throttle position. Usually, it
carries out from a rotation speed somewhat higher
than idol rotation speed. Since it is easy to carry out a
stole when engine has got cold, a higher rotation
speed is specified. In a right figure, for example,at the
engine temperature of 70 degrees C or more, when a
throttle is an idol position in 3500r.p.m or more, fuel
injection is stopped. In 23degree C,Injection is not
stopped lower than 8000r.p.m.

This functions also as an idol R.P.M. limiter.

FCdesign

Injection Time (msqc) : D.amsecizcale
10

G—

-50 0 170
Engine TemperatureldegC) : 20 degllfzcale

Injection Time (msec) | 0.Smseciscale
5

Thrattle Speed(%eicicle) | 10%/ciclelzcale

Revoltion Speed (RPM) - 1000RPMiscale
16000

-50 1] 170
Engine TemperatureldegC) : 20 degCizcale
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Accelerate Compensation (for *D-Jetronic only )

Compenzation Yalue (11 D.Sisqale
5
This function correct a gap of the air / fuel ratio by the

following reasons.

a) Response delay of intake pressure sensor.

b) The difference in the fuel evaporation by the
intake pressure at the time of acceleration or
a slowdown. (Throttle open or close)

B ] a 100
Thiottle Speed%icicle]  10%kciclefzcale

When Throttle changes in the direction it opens, the
volume of fuel is increased. Because engine is

changing in the direction whose intakeair volume time to recovery
increases and the value of a sensor is following

behind time. Conversely, fuel is decreased when a =l
throttle changes in the direction which it closes. j
Because intake air volume is changing in the direction recovery time from 097 sec
decreasing and the value of a pressure sensor follows 22U

later than it. In this compensation, when a throttle
changes, a value is set, and a value is increased or
decreased gradually. Compensation will be ended if a
value is setto 1.0.

You can set up the value to 0 to 5 times to the point
of the throttle change speed of arbitrary acceleration
or the slowdown direction.

The value to increase, or the value to reduce is set
up in a lower window. It sets up with this button. If an
upper button is clicked, it will come to return early,
and if a lower button is clicked, it will come to return
slowly.

It differs from the asynchronous injection which
performs compensation injection temporarily that the
volume of synchronous injection is increased or
decreased between a certain set-up cycles.

*"D-Jetronic" is the registered trademark of Bosh AG
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[ Data Monitoring Window ]

Among the control parameters in ECU, the
following information can be displayed on
the screen of PC by using the
communication. Open rate of throttle,
temperature of engine, value of dial
controller, and rotational speed of engine,
voltage of battery, and injection time

Please connect ECU with the PC with the
communication cable.

Next, please operate "download from ECU"
referring to the chapter of " Read Settings
from ECU".

When the reception is completed, please
click "Tool" >> "Data Monitor" of the
menubar. The data monitor window is
displayed.

When "Start" button is clicked, it starts
displaying.

The raw data of the sensor is displayed in
the left, and the converted physical quantity
is displayed in the right. An open rate of the
throttle is converted into an open aria rate of
throttle boa. The open rate of the throttle
used in the basic injection map is this open
area rate.

In throttle open rate and engine temperature,
PC converts into a physical numerical value
when the engine speed is zero, and displays
them by a red character. When the engine
starts rotating, the value in which the
conversion calculation is done with ECU is
displayed in blue.

Irl RE Fm | -l A
REC N OITEREOEE |L

et [ EEIEE BIEE-bEE

f
starting "Data monitor"

FETTTTTEE—
=] e o= |

[ o= Pk ke

-

h.g--m-i L] 1R

Gt i
_Bepriwr !__.

[y S

By Viksgs | [

Data Monitor Window

DJ Input Statusz Monitor

2 | 55997 | Glose |

Click "Start" button to display.

[ For the D-Jetro version |

"intake manifold pressure"” is
added to the display item.
Only after the engine starts,
PC displays pressure value.
Before starting,the value is
displayed by a red character
as "760".

* Even if the dial controller's setting is "diabled”, the numerical value displays the

value of the dial.

* After engine starting, some parameters are displayed in red charactor.
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Other operations of SWB cannot be done
while receiving the timer.

frea Percentage(X) I 104 scale
0o
A right graph displays the position of i
referred map. The graph can be cleared with -

the button of "Graph Clear".

g g u]
After the "communication" is stopped by =88
"stop"button, the window can be shut with - =
the "Close" button. . I o
0 16000

Revolution SpeedCrpm)

In D-Jetro version

"Aria Percentage" is changed "Manifold
Pressure” .
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(3) configure and sensor ajustment

Before use,it is necessary to do "Hardware Configuration" and "Map Adjustment”
after ECU is installed to the vehicle. These settings are usually set when "FC
design" ships it.However, the thing that shifts by engine vibration the idle adjusting
etc. is expected. This chapter explains these adjusting methods.

The set item.

As a hardware configuration.
(1) Setting of close values and full open value of throttle sensor.
(2) Setting of threshold for idle throttle value judgment.

As an adjustment of the map
(3) Adjustment by capacity of injector and displacement of engine.

[Setting of close values and full open value of throttle sensor.]

ECU must convert from the voltage of the throttle sensor into an open rate of the
throttle and refer to the jet map.
The setting to which open rate the voltage of the sensor hits changes according to
the installation position of the sensor and the operation angle of the throttle valve.
It has usually adjusted it in "FC design" before ECU is shipped. However, it is
likely to shift the overhaul of the throttle body or caused by loosening of the
installation by the vibration under use. We will explain the method of adjusting this
value here.

(i) Read Full Open Value

Cimr = yer |

At first, please operate starting "Data “,,,("T'\ CTEm
monitor"( refer to "Data Monitor Window" P i e |
chapter). e
Open the throttle to the wide(full open) limit. |- ] '
when click "Start" button, the e T
communication begins. Afterwards, please e R :;-.:mf
read the value of the throttle sensor (value R wan 10 |
of 0-255).

If the value is 255 ,please loosen the Data Monitor Window

sensor installation screw of the throttle body,
and adjust to become a value that is

smaller than 254 while seeing the sensor
value of Datamonitor.
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(i) Read Full Close Value

In the same way, please read the value at e
full close position. At this time, please rotate
the idol adjustment screw until becoming a f S
position in which not the idol position but the : toloal o
throttle is completely closed. Please read the | | =

value at the position in which the throttle is | Lmmsin—
completely closed. ol

(|||) Set Value to PC — Throttle Body

Throttl

Digfnet?ar {mm] F20
Next, please set the sensor value to ECU S;ar;__sclnlrgalue
,according to the following methods. o oo v

_ _ ) ensor Value [ 8] Manual |

Please return to the main window, and click of Close .
n n n M M n t
Tool" >> "Hardware configuration" of the | i

menu. opens.

When the message is displayed, click "Continuation" button, please.

"ECU Configuration" window The value is set to the frame of "Throttle body" on
the left top of the window. Please input the sensor value of full open throttle to the
box of "Sensor value of full open”.

When the button of "Manual" in the right of the box , "Sensor value of close" is
clicked, the input window opens. Please input the sensor value of full close throttle
here, and click the "OK" button.

when the message of "Value is incorrect” is displayed ,the input value may be
wrong, please try again from the step,"the full open value".

The input of "Throttle Diameter" is arbitrary. Please use it as a memo of the
setting(Map).

(iv) Transmit to ECU

Please confirm the connection of the communications cable, confirm the power
supply of ECU is turning on, and click the "PC>>ECU" button.

The mouse icon becomes an "hourglass” display while transmitting, and,
meanwhile, SWB cannot be operated. It takes about ten seconds to transmit.
The message of "Complete” is displayed when the transmission is completed
and click the "OK" button, please.

The power supply is turned off. ECU maintains the power supply while writing
the setting, and the power supply cuts afterwards.
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